
SpeakSpace Web Conferencing
Quick Reference Guide

Welcome to SpeakSpace Web Conferencing, the place where people come to connect
with each other and get more done. It provides an easy, intuitive way to host small
collaborative meetings and conduct informational webinars with thousands of participants.

With SpeakSpace Web
Conferencing, your Instant
and Scheduled meetings
are easy to organize and
conduct. Simply schedule
and invite participants to
your meeting using
Microsoft Outlook®.

When you are ready to
meet, either launch
SpeakSpace Web
Conferencing from your
desktop or click the
SpeakSpace Web
Conferencing link in your
invitation and you are
instantly placed into your
meeting space. It’s that
easy. You have the tools to control the meeting, engage with participants and ultimately,
get work done more efficiently.

SpeakSpace Web Conferencing also offers a full-featured web conferencing service that
lets you easily conduct engaging, online events from start to finish for virtually any size
audience. From scheduling the webinar to delivering your content to accessing detailed
post-event reports, SpeakSpace Web Conferencing offers comprehensive and easy-to-
use tools, so you are free to focus on your message and your audience.

The following guide delivers quick steps to start or join an Instant meeting, as well as
great tips for managing your remote conferences. For Scheduled meetings, this guide
also provides quick steps to planning, conducting and measuring your online events.

For support, contact the 24/7 SpeakSpace Web Conferencing helpdesk:
Phone: 866.562.2306 or +1.303.928.3344
Email:

o Technical support: techsupport@webvisuals.net
o Customer service: customersupport@webvisuals.net
o General inquiries: info@webvisuals.net

UR MEETING



Things to Do Before Your Instant or Scheduled Meetings

INSTANT OR SCHEDULED MEETINGS: MANAGEMENT PAGES

SpeakSpace Web Conferencing Management Pages let you prepare for and wrap-up
your meetings. Whether you want to view and manage recorded meetings, store
documents, access reports or create and edit polling questions, your Management Pages
allow you to do it all.

Q: How do I access Management Pages?
A: To access your Management Pages, refer to your welcome email containing your
account information or click the URL located on your home screen in SpeakSpace Web
Conferencing. You can also direct your participants to your Management Pages to view
stored documents or listen to recorded meetings.

INSTANT MEETINGS: SEND INVITATIONS

Q: Can I use Microsoft Outlook to invite participants to a meeting?
A: Yes. However you must first enable Outlook integration with SpeakSpace Web
Conferencing. On the Tools menu, click Enable Outlook Integration.

Q: How do I invite people to an Instant meeting?
A: There are two ways to invite participants:

1 Before the meeting – If Outlook integration is enabled, click New Meeting in
Outlook. An Outlook meeting* invitation displays.

2 Before or during the meeting – On the File menu, click Send Email Invitation.
Your default email program displays. Your email invitation is pre-populated with
the meeting login information, and participants join your meeting by clicking the
link.



Q: Do participants automatically join a meeting when accepting a SpeakSpace Web
Conferencing invitation?
A: No. By accepting an Outlook meeting invitation, participants schedule the meeting in
their calendars and notify the moderator. To join the meeting, participants must click the
link in the meeting invitation at the scheduled time.

SCHEDULED MEETINGS: CREATE EVENTS, SEND INVITATIONS
AND MANAGE REGISTRATIONS

Create a Scheduled Meeting

Q: How do I create a new event?
A: To create a new event using the Event Creation Wizard:

1 Click My Events.
2 Click Create New Event.
3 Enter the event information. To navigate through the screens, click Back and

Next.
4 Click Finish to review your event details.
5 Click Save to save the event without scheduling or click Schedule & Save to

schedule your event. Emails will be sent to your invitees if you schedule and save
your event.

Q: How do I edit an event?
A: To edit an event:

1 Click My Events.
2 In the list of scheduled events, select the event you want to edit.
3 Enter the updated event information.
4 Click Update.

Q: How do I copy an event?
A: To copy an event:

1 Click My Events.
2 In the list of scheduled events, select the event you want to edit.
3 Enter the updated event information (i.e. date and time).
4 Click Update.



Contact Lists for Scheduled Meetings

Contact lists are lists of invitees that are maintained in the Management Pages and can
be used for any event.

Q: How do I create a new contact list?
A: To create a new contact list:

1 Click Contact Lists.
2 Click Create New Contact List.
3 Enter contacts individually, from past

events, from a comma separated value
(.csv) file or from other contact lists.

4 Click Save.

Q: How do I edit a contact list?
A: To edit a contact list:

1 Click Contact Lists.
2 Click the pencil icon next to the contact

you want to edit.
3 Enter contact list information.
4 Click Save.

Invite Participants to a Scheduled Meeting

Q: How do I invite people to an event?
A: You can invite people to an event by:

Entering individual information for each invitee.
1 From the Invitees tab, click By Individual.
2 Enter the invitee information into the fields.
3 Click Add.

Choosing invitees who were invited to a past event.
1 From the Invitees tab, click From Past Event.
2 Click Add next to the event name.

Importing invitee information from a .csv file.
1 From the Invitees tab, click From .CSV File.
2 Click Browse to locate the .csv file on your computer.
3 Click Upload.

Choosing invitees from an established contact list.
1 From the Invitees tab, click From Contact Lists.
2 Choose the contact list from the menu.
3 Click Add.

Event Registration Approvals for Scheduled Meetings

Q: How do I approve or deny event registration requests?
A: To approve or deny event registration requests:

1 Click My Events.
2 Click the process registration request icon next to the event.
3 Click the green check mark to approve a participant’s registration or the red

check mark to deny it.

You may also select Approve All Pending Requests or Deny All Pending
Requests.



Upload a Presentation for a Scheduled Meeting

You have the ability to upload your presentations before or during your event.

Q: How do I upload a new presentation for an event?
A: To upload a new presentation:

1 Click My Events from your Management Pages.
2 Click the pencil icon next to the event to which you want to add the

presentation.
3 Select the Event Materials tab within your event.
4 Click Upload New to upload and store the presentation on the SpeakSpace Web

Conferencing’ servers or click Use Shared Local to use a document that resides
on your computer.

5 Enter the presentation name. This is not required if using a shared local
presentation.

6 Click Browse to locate the file on your computer.
7 Click Submit.

INSTANT OR SCHEDULED MEETINGS: POLLING QUESTIONS

Polling questions are created before or during a meeting to gather information from
participants during the meeting.

Q: How do I create a polling question set?
A: To create a polling question set before a
meeting:

1 Log into your Management Pages.
2 Click Question Sets.
3 Click Create New Question Set.
4 Name your question set.
5 Enter your questions.
6 Enter either customer answers or

select from pre-set answers. Each
custom answer must be on its own
line within the field.

7 Click Add Question.
8 Click Save.

Q: How do I add a new polling question?
A: To add a new question to an existing polling
question set:

1 Select the Add Question tab.
2 Click the pencil icon next to the

question set you want to modify.
3 Enter your question.
4 Enter either custom answers or select from pre-set answers. Each custom

answer must be on its own line within the field.
5 To allow more than one answer to be chosen, select Allow participants to

select more than one answer.
6 Click Add Question.
7 Click Save.



INSTANT OR SCHEDULED MEETINGS: STORED DOCUMENTS

Stored documents are documents uploaded to your Management Pages and made
available to your participants for download.

Q: How do I upload a new stored document?
A: To upload a new stored document:

1 Click Stored Documents from your Management Pages.
2 Click Upload New Stored Document.
3 Complete the document details.
4 Specify who can access the document.
5 Click Upload Document.

INSTANT OR SCHEDULED MEETINGS: BILLING CODES

Billing codes are numbers you assign to meetings that enable you to track expenses in
order to charge a conferencing fee back to a client or an internal group.

Once this feature is active, you are prompted when starting a meeting to enter a billing
code or choose a previously used billing code from the menu in the billing code dialog
box. If there is not a billing code associated with your meeting, click Cancel when the
billing code dialog appears.

INSTANT OR SCHEDULED MEETINGS: ADDITIONAL SECURITY

Q: What are passcodes?
A: Passcodes are four- to nine-digit codes that provide an additional layer of security for
your meeting. In your profile, from the Security tab, select Prompt me to set a new
passcode for every meeting. Participants joining a meeting secured by a passcode
must enter the passcode before they can join.

Q: How do I create a new passcode for Instant meetings?
A: To create a new passcode within SpeakSpace Web Conferencing:

1 On the File menu, click Edit Profile.
2 Select the Security tab.
3 Choose Prompt me to set a new passcode for every meeting in your profile.
4 Start a new meeting. The passcode dialog displays.
5 Enter the passcode in the field or choose a previously used passcode from the

drop-down menu.
6 Click OK. Your participants are prompted to enter that passcode when joining

your meeting.

Q: How do participants know the passcode for my Instant meeting?
A: To ensure participants know the passcode for your meeting, it must be included in the
meeting invitation. If you are inviting participants before or during a meeting by sending an
email invitation through SpeakSpace Web Conferencing, your passcode is automatically
inserted.



Q: How do I give participants the passcode for my Instant meeting?
A: Before you start your meeting, create your passcode. If you already selected to set a
new passcode for every meeting in your profile, click SpeakSpace Web Conferencing
Meeting Information in your Outlook invitation and enter the passcode in the passcode
field.

Q: How do I create a new passcode for Scheduled meetings?
A: You may specify passcodes for your events on the Event Details tab within the Event
Creation Wizard. Participants joining an event secured by a passcode must enter the
passcode before they can join.

Q: How do participants know the passcode for my Scheduled meeting?
A: To ensure participants know the passcode for your event, it must be included in the
invitation. The default email text for joining an event includes a placeholder for an event
passcode, which will automatically populate if you specify a passcode for your event.

Q: Can I encrypt my meeting or event for additional security?
A: To encrypt specific features:

1 On the File menu, click Edit Profile.
2 Select the Security tab.
3 Select the checkbox by the features you want to encrypt.
4 Click OK.

To end feature encryption, clear the checkbox for that feature. If you change your feature
encryption settings during a meeting, you must first log out and then log back in for
changes to take effect.



Start Your Instant or Scheduled Meetings

INSTANT MEETINGS: GETTING STARTED

Q: How do I start an Instant meeting?
A: To start your meeting, double-click the SpeakSpace Web Conferencing desktop icon.
From your SpeakSpace Web Conferencing home screen, click Start a Meeting. You are
prompted to select or enter a phone number. You will be called at this phone number to
start the phone portion of the meeting.

SCHEDULED MEETINGS: GETTING STARTED

Q: How do I start a Scheduled meeting?
A: To start a Scheduled meeting:

1 Click View Schedule from your Management Pages.
2 Click Start Now next to the event you want to start.
3 Click Start Event or Start Event in Practice Mode. Practice mode enables you to

start your event without allowing participants to enter.

INSTANT OR SCHEDULED MEETINGS: PROFILE INFORMATION

Q: How do I change my profile information?
A: To change your profile information:

1 From your SpeakSpace Web Conferencing home screen, click Manage Your
Account.

2 Click Change next to Your Personal Info.
3 Edit the fields to change your profile information.
4 Click Change.

Q: How do I choose what profile information is shared in a meeting?
A: To choose your profile information shared in a meeting or event:

1 On the File menu, click Edit Profile.
2 Select the Share In Meeting check box of the profile information you want to

share.
3 Click OK.

Things You Can Do During Your Instant or Scheduled
Meetings

INSTANT OR SCHEDULED MEETINGS: FEATURES

Reservationless-Plus® Integration

Q: What equipment do I need to use the integrated Reservationless-Plus
conferencing?
A: You only need a phone to take advantage of the integration between SpeakSpace Web
Conferencing and Reservationless-Plus conferencing.

Q: How do I start a meeting using Reservationless-Plus?
A: If integration with Reservationless-Plus is enabled, when you start the web portion of
the meeting, you will be prompted to do the following:

1 Enter your number and select your country of origin.
2 Select the audio option for participants (Phone Only, Audio Broadcast Only or

Phone and Audio Broadcast).



If you do not receive the prompts, select Audio from the drop-down menu in your toolbar,
then follow the steps above.
Live Desktop Video

Q: What equipment do I need to use video?
A: To be seen by other participants, install a web camera before starting SpeakSpace
Web Conferencing. Your web camera transmits live video of you to other participants.

Q: How do I know if my video is working?
A: If your web camera is installed and on, you will see your live video displayed in the
Meeting Bar.

Q: Can I turn my live video off so participants cannot see me?
A: Yes. Click the double arrows above the video window to collapse the Video controls.
The status will change from On Air (transmitting video) to Off Air (not transmitting video).

Q: How do I ensure my video is being displayed to all participants?
A: To display your video to all participants click Video Options and then click Take
Podium.

Q: How can I see live video of the person speaking?
A: To see the video of the person speaking, in the Participant Task Group, click that
person’s name. If you are
speaking and want to display
your video to all participants,
select Take Podium.

Q: What if I do not have a
web camera?
A: If you do not have a web
camera, you can participate in
a meeting and see other
participants’ video, but you are
not able to send live video.

Presenting or Sharing
Content
Q: What options do I have for presenting or sharing content?

A: You can convert a document using Document Viewing, share an application using
Application Sharing or share a browser using Browser Sharing.

Q: Why should I convert a document in Document Viewing rather than share it
using Application Sharing or Browser Sharing?
A: Converting a document gives you the following benefits:

Less bandwidth: minimal bandwidth is required for viewing.
Quick retrieval: converted documents are stored in your documents directory for
easy retrieval later.
Easy access: converted and presented documents are saved in Meeting History
for participants to view at any time during your meeting.

Q: What are the benefits of Application Sharing or Browser Sharing?
A: The benefits of sharing are:

Quick presentations viewed on-the-fly; no conversion is necessary.
Browser sharing is live, enabling real-time presentations.
Any desktop application can be shared with participants.



Ability to pause during application or desktop sharing to annotate directly on the
screen.

Sharing an Application or Browser

Q: What is sharing an application or browser?
A: You can present an application or web browser from your computer during a meeting.
You can share a specific file, a selected region of your desktop or your entire desktop for
other participants to view and annotate. If given permission, a participant can do the
same.

Q: How do I share an application?
A: To share an application:

1 In the Meeting Bar, click Application Sharing. Icons for open applications and
desktop and region sharing icons are displayed in your Private Workspace.

2 Click any application icon to begin sharing that application, click Share Desktop
to share your entire desktop or click Share a Region to select a specific region of
your desktop for sharing.

Q: How do I share a browser?
A: To share a web page:

1 In the Meeting Bar, click Browser Sharing.
2 Enter a web address in the URL field displayed

in your Private Workspace or choose a
previously viewed web address from the drop-
down menu. You can take users to any web site,
secure (password-protected) or non-secure.

Document Viewing

Q: Why do I need to convert my documents before
presenting?
A: Before you can present a file with Document Viewing,
you must convert it. When a document is converted, it is
saved as a *.rdi document on your hard drive. Conversion does not change your original
document; it simply saves it in a format that enables easier presentation during the
meeting. You can convert documents before or during a meeting. A converted document
can only be viewed while using SpeakSpace Web Conferencing.

Q: What types of documents can be converted?
A: The following file types can be converted and presented in SpeakSpace Web
Conferencing: *.doc, *.ppt, *.vsd, *.xls, *.txt, *.pdf, *.prz, *.jpg, *.jpeg and *.bmp.

Q: How do I convert a document?
A: To convert a document:

1 In the Meeting Bar, click Document Viewing.
2 Click Convert a Document.
3 Select the file you want to convert and then click Open.
4 When conversion is complete, choose Permanently save to stored documents

and/or Open in Meeting to immediately open the converted file for presentation
in your Private Workspace. If you will be working with other presenters, select
Make available to co-moderators and presenters

5 Click OK.

Recording

Recording lets you capture a synchronized audio, web and video playback of your
meeting. After the meeting, make the recording available to others for later playback.



Note: To utilize the built-in recording feature, you must use Reservationless-Plus
conferencing integrated with SpeakSpace Web Conferencing.
Q: How do I record a meeting using Reservationless-Plus?
A: To record a meeting:

1 In the Meeting Bar, click Recording Controls.
2 Click Start Recording.
3 Enter a title for the recording.
4 Select Include webcam video in recording to include live video in the

recording. Clear the checkbox to omit live video from your recording.
5 Click Start Recording. When recording begins, Recording In-Progress will

display above your Public Workspace and you will also hear "Your conference is
now being recorded" on the phone.

Q: How do I record a meeting if I am using Operator Assisted conferencing?
A: To record a meeting using Operator Assisted conferencing, please contact technical
support.

Question & Answer

Question & Answer enables co-moderators, presenters and participants to ask text
questions during a meeting, if given permission. Moderators, co-moderators and
presenters can answer questions.

Q: How do I know when a question is being asked?
A: There are two ways to determine when a question is being asked.

1 When the Question & Answer feature is open, questions are displayed in your
Private Workspace.

2 When the Question & Answer feature is not open, the Question & Answer option
in the Meeting Bar will flash.

Q: How do I answer a question using Question & Answer?
A: To answer a question:

1 In the Meeting Bar, click Question & Answer. The Question & Answer interface
appears in your Private Workspace.

2 Click a question in the Questions Outstanding box.
3 Enter an answer in the Answer box.
4 Click Answer to answer the question privately or click Answer to All to answer

publicly.

Polling

During a meeting you can gather real-time feedback from your participants and publish
the polling results.

Q: How do I ask a polling question?
A: To ask a polling question:

1 In the Meeting Bar, click Polling. The Polling interface appears in your Private
Workspace.



2 Select a question set.
3 Click Open Poll.

As participants answer the polling question, their responses are displayed in your Private
Workspace. When you are ready, close the poll and publish the results.

Q: How do I create or update a polling question set while in a meeting?
A: To create or update a polling question set while in a meeting:

1 In the Meeting Bar, click Polling. The Polling interface appears in your Private
Workspace.

2 Select either an existing question set to edit or choose New Question Set from
the drop-down menu to create a new question set. Click Edit Question Set.

3 Create or update the question set.
4 Click Save.

Chat

Chat enables you to exchange text messages with all participants, moderators, co-
moderators or specific participants.

Q: How do I chat with participants?
A: To chat with individual participants:

1 In the Meeting Bar, click Chat. The Chat dialog box opens.
2 Choose an appropriate recipient for your message.
3 Enter your message in the text entry field at the bottom of the Chat dialog box.
4 Click Send.

Your message is displayed in the upper area of the Chat dialog box. When you receive a
message, it is posted in the same area.

Annotation

Q: Can I annotate a presentation or shared application?
A: Yes. You can select an annotation tool to draw or write notes while whiteboarding,
presenting a document or when application sharing or browser sharing is paused.

Q: What is Meeting History?
A: Meeting History displays presented whiteboards, presentation slides or any other
converted document that has been presented in your meeting.

To view Meeting History in your meeting:
1 On the Meeting Bar, click Document Viewing.
2 Select Meeting History from the drop-down menu in your Private Workspace.

Force Full Screen

For even more control over your participants’ view, you have the option of forcing all
participants into full screen mode.

To force full screen for your participants, click the force full screen icon . To return your
participants' screens to the normal view, click the force normal icon .



Participant Management

Q: How do I assign a new role or set custom permissions for a specific participant
during a meeting?
A: To assign a new role or set custom permissions for a participant:

1 In the Meeting Bar, click Participant Details. A list of participants appears in
your Private Workspace.

2 Right-click the participant’s name and click Permissions.
3 Choose a new role (co-moderator, presenter or participant).

These permissions and roles apply only to your current meeting.

Q: How do I join participants into the phone portion of a meeting using
Reservationless-Plus?
A: When you start the phone portion of the meeting, participants are prompted to enter a
phone number where they will be called and select their country of origin. You do not
need to manually call participants.

Q: How do I dial out to a participant from within a meeting using Reservationless-
Plus?
A: To dial out to a participant:

1 In the Meeting Bar, click Participant Details. A list of participants appears in
your Private Workspace.

2 Right-click the participant’s name in your Private Workspace, then click Call.



3 Select or enter a phone number.
4 Click OK.

Q: How do I mute and unmute participants’ phones if I am using Reservationless-
Plus?
A: To mute all participants' phones, click the mute all audio icon in the main toolbar at
the top of the application. To unmute all participant phones, click the unmute audio icon

. To mute or unmute an individual participant's phone:
1 In the Meeting Bar, click Participant Details.
2 Right-click a participant's name in your Private Workspace, then click Mute or

Unmute.

Q: What is Request Phone Association?
A: Request Phone Association enables moderators or co-moderators to associate a web-
only participant with an audio line.

Q: How do I associate web-only and audio-only participants?
A: To associate a web-only and an audio-

only participant as listed in the Participant
Task Group:

1 Right-click the participant's name.
2 Click Associate. When the

participant is web-only, a list of
audio-only participants displays
and vice versa.

3 Select a participant from the list.
4 Click OK. The participant now

displays in Participant Details as
one name with both web and
audio.

Q: How do I play the recorded name of a participant?
A: Play Name allows moderators or co-moderators to play the name a participant
recorded when joining the audio call and hear it through the phone.

To play a participant’s recorded name:
1 In the Participant Task Group, right-click the participant’s name.

2 Click Play Name.

Q: How do I rename a participant listed in the Participant Task Group?
A: To rename a participant:

1 In the Participant Task Group, right-click the participant's name.
2 Click Rename.
3 Enter the new name.

Q: How do participants connect to the phone portion of a meeting after they have
joined online?
A: To join the phone portion of a meeting using Reservationless-Plus:

If you have already started the phone portion, participants are prompted to select
or enter a phone number where they will be called. Alternatively, participants can
dial into the meeting. In the Meeting Bar, click Meeting Information then click
Dial-In Instructions. Follow the instructions to join by phone.
If you have not started the phone portion when participants join online,
participants can later request the meeting to call them when you arrive. In the



Meeting Bar, click Phone Controls. The Phone Controls appear. Click Join
Phone Conference.

Things to Do After Your Instant or Scheduled Meetings

INSTANT OR SCHEDULED MEETINGS: RUN REPORTS

Reports are available within your Management Pages and allow you to access
information about your meetings.

Q: How do I generate a report?
A: To generate a report:

1 Click Reports in your Management Pages.
2 Select a date range.
3 Choose a report type.
4 Apply a filter.
5 Click Run Report.

INSTANT OR SCHEDULED MEETINGS: ACCESS RECORDINGS

Q: How do I make my recorded meeting available to others?
A: There are two ways to make your recorded meeting available to others:

1 Send an email containing a playback link.
2 Download the recorded meeting and Meeting Player.

Q: How do I send out a playback link from my Management Pages?
A: To send a playback link:

1 Click Recorded Meetings in your Management Pages.
2 Click the envelope icon next to the meeting for which you want a link. You will

receive a link via email and can then forward it to recipients.

Q: How do I download a recorded meeting from my Management Pages?
A: To download a recorded meeting:

1 Click Recorded Meetings in your Management Pages.
2 Click the orange arrow icon next to the meeting you want to download.
3 View confirming information on the following page and click Download

Recording.
4 Click Save in the file download dialog box.
5 Select a location to save the recording and click Save.

The Meeting Player is needed to playback a downloaded meeting.



Q: How do I play back a recorded meeting from my Management Pages?
A: To play back a recorded meeting:

1 Click Recorded Meetings in your Management Pages.
2 Click the green arrow icon next to the recording you want to play back.
3 If the recording is password-protected, enter the password.
4 Choose your network connection speed by clicking Low, Medium or High.
5 Click Play Recorded Meeting. The Meeting Player displays and the recording

begins to play. I

Participate in Instant or Scheduled Meetings

INSTANT MEETINGS: JOIN PARTICIPANTS

Q: How do participants join my meeting?
A: There are two ways participants can join a SpeakSpace Web Conferencing meeting:

1 Once SpeakSpace Web Conferencing is installed, double-click the Web Visual’s
desktop icon.
Click Join a Meeting.
Enter the conference ID you provided or select a previously entered conference
ID from the drop-down menu.
Click Join Meeting. Participants are either placed directly into the meeting or are
instructed to wait for you.

2 An email invitation:
Click the meeting link in the email invitation. If participants accepted an Outlook
meeting request, they must open the appointment in their calendars and click the
link.
Enter the required information and the conference ID you provided.
Select either the full version or light version depending on individual operating
system and/or bandwidth.
Click Join Meeting.

In any of the above cases, when you arrive, participants are prompted to select or enter a
phone number to join the phone portion of the meeting. Participants are called at this
phone number and joined into the phone portion of meeting.



SCHEDULED MEETINGS: REGISTER PARTICIPANTS

Q: How do participants register for a scheduled event from an email invitation?
A: To register for a scheduled meeting:

1 Click the link in the email you provide.
2 Enter information into the appropriate fields, including a unique username and

password that can be used for future logins.
3 Click Register.

The status of registration is now pending your approval. When approved, the participant
can join the scheduled meeting.

SCHEDULED MEETINGS: JOIN PARTICIPANTS

Q: If a participant pre-registers for an event, how do they join the event from an
email?
A: For participants to join a scheduled event:

1 Click the link in the email you provide.
2 Login with the username and password created during registration.
3 Select either the full version or light version depending on individual operating

systems and/or bandwidth.
4 Click Join Now.

INSTANT OR SCHEDULED MEETINGS: ASK A QUESTION

Q: How can a participant ask a question using Question & Answer?
A: For participants to ask a question using Question & Answer:

1 Click Question & Answer in the Meeting Bar. The Question & Answer interface
appears in the participant's Private Workspace.

2 Enter the question.
3 Click Submit.


